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Introduction
Congratulations on purchasing themost productive programming system available! We
recommend that you review Getting Started and this guide beforemoving on toMill, Turning,
Mill/Turn, or any other GibbsCAMproduct guide. The best way to learn the system is to read the
reference information and complete the geometry exercises, and then complete the associated
tutorials.

This guide is intended for all GibbsCAMusers. The information in this guide applies to the basics of
creating geometry (and the basics of a part file in general) across all GibbsCAMproduct modules.
We strongly recommend that, at a minimum, you familiarize yourself with the followingmaterial:

• About Geometry Creation in GibbsCAM

• GeometryOverview

• Working with Geometry

The tutorials for geometry creation focus on basicmilling or turning parts. You shouldmaster them
before proceeding to the tutorials for Mill or Turning.

Online Help and Balloons
For simple explanations of items and their purpose, useOnline Help, and Balloons. Online Help,
Balloons, and PDFs are built-in systems of documentation and training information. They are
enabled from the Helpmainmenu.

Online Help is a context sensitive Help system.When activated the online help will bring you to a web
page that is relevant to the dialog you are working in. Online Help can also be browsed or searched.

Balloons (Ctrl+B) provide reference information about any object that the cursor is placed over.

The PDFs are electronic versions of the GibbsCAMguides. The PDFsmay be browsed, searched
and print well if you need a hardcopy. The CommonReference guide will help you with items
contained in theMenu Bar.

System Overview
Theworkflow is designed to be extremely flexible and to allow the user the freedom to create parts
in anyway that comes naturally. The “modeless” interface allows the user to have geometry
creation, tools, machining capabilities and post processing functions available at all times.
However, there are certain basic elements required to create a part. Geometrymust be created. At
least one toolmust be defined and toolpathmust be generated before a part can be post
processed. TheMain palette is organized in a logical manner for building a part. A part does not
have to be created in this order, it only serves as a guideline.
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About Geometry Creation in GibbsCAM
If you have ever used a design CAD software package to design, draw, or create geometry, the first
thing you will notice about GibbsCAM is that the geometry CAD tools are different. This can lead to
a number of different possible first impressions, including that different is “bad” especially when it is
different fromwhat you have already learned how to use.

In the case of GibbsCAM “different” is not just for difference sake. Throughout our software, we
strive for consistency in our interface and usage so that clients can be productive quickly without a
steep learning curve. There are reasonswhyGibbsCAMCAD is different, starting with the fact that
it is not intended for the same task or the same user as design CAD software.

There are typically several important steps inmodern part manufacturing, including Design CAD,
Manufacturing CAD, and CAM.

Design CAD
This is the creation of a new design performed by a design engineer using a design CAD software
such as SOLIDWORKS, SolidEdge, AutoDesk, PTC Creo Parametric (Creo
Elements/Pro/ENGINEER), Catia, or Unigraphics. The software for this function needs to support
the designer's creativity with a variety of freeformCAD capabilities.

Manufacturing CAD
At this point amanufacturing expert receives a design from someone else — another department or
another company. Themanufacturing expert may need to redraw the file, import CAD files, or
repair/correct the design for manufacturing. Additionally, themanufacturing expert may need to
create processmodels, tooling, or fixtures from the part design. A key point is that this is usually not
the person doing the original design.

CAM
This is creating the NC program. Once themanufacturing expert has the geometry or part models
ready tomachine, they can proceed with planning and creating the actual tools, toolpaths andG-
code needed tomake a good part.

GibbsCAMexcels at Manufacturing CAD andCAM, which is everything themanufacturing expert
needs to complete the job begun by the design engineer. The users and tasks of GibbsCAMare
very different from the users and the tasks of a design CAD software. GibbsCAMCAD is aimed at a
different user and a different task and therefore is different.

In the infrequent case where the designer and themanufacturer are the same person, theymay
choose to useGibbsCAMCAD just because they like it, or theymay choose to use a design CAD
for designing. Theywould then link files to GibbsCAM for Manufacturing CAD andCAM.

Wewill look at some of the waysGibbsCAMgeometry creation is different and why.
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Redrawing Time
WhenGibbsCAMwas first released, in 1993, much CAD workwas still sent to themachine shop by
blueprint. This required themanufacturing expert to redraw it. GibbsCAM set out to provide tools
that allowed a shape to be redrawn faster and easier than design CAD systems could. GibbsCAM
CAD tools achieve this, allowing redrawing to be done in a fraction of regular CAD time. Geometry
Expert pushes this advantage further by providing parametric capabilities for family-of-parts
creation and interactive shape editing.

Just The Finished Part
You do not need to recreate an engineering drawing tomake a program. GibbsCAM focuses on
creating finished shapes tomachine, not recreating an engineering drawing. GibbsCAMdoes not
require that additional geometry be created for entry and exit tool moves; we just need the finished
part.

Chaining
AnyCAM system using design CAD as the front end has a “chaining” step. Chaining attempts to
automatically connect one feature with the next into amachinable shape. This process stops and
asks the user “which way?” whenmore than two features intersect on the screen. In a complex
drawing, this can be a cumbersome process. The issue with chaining gets worse when the chaining
function finds a small gap which is commonwith imported geometry. In such a case, youmust go
back to the CAD, fix the problem, go back to chaining, find the next error, and repeat the steps.
GibbsCAMeliminates the chaining step by allowing users to create linked/connected geometry. In
effect, when you are finished drawing a shape, you are assured that it is already chained and ready
for machining.

Fast and Easy?
There is a big difference between the best way to draw in GibbsCAMand the best way to draw in a
design CAD system. GibbsCAMdoes not have a design CAD style “trim” function. Instead, it uses
“connectors” to link one feature with the next, automatically trimming the shape graphically when a
feature has two connectors. A machinist can think of drawing a shape like taking a tool around a
part in G-code in a sequence of lines and circles.

A design CAD user frequently approaches drawing a part quite differently, creating a large number
of untrimmed lines and circles, then going back through them “trimming”. GibbsCAMCAD is always
focused on drawing a shape to bemachined. You simply need to define the lines and circles in
some order around a shape. Going clockwise or counterclockwise doesn't matter; where you start
making geometry and the direction you go has no effect onmachining, because you are just
drawing a finished part shape.

When you start defining your geometry elements in shape order, a wonderful thing happens — there
are rarelymore than 2 untrimmed elements on the screen at a time. Connecting and trimming are
automatic. You can draw a shape in fewer user actions and eliminate chaining all at the same time.
This is a win-win situation whichmakes learning a different approach to drawing (or redrawing)
worthwhile.



GeometryOverview

9

Geometry Overview
Geometry consists of lines, circles, curves (splines) and points. Geometric featuresmay be
connected into complex shapes in 2D or 3D. Connecting points (blue squares) are referred to as a
connectors while end points are called terminators and are drawn as yellow squares. Each feature
has a reference number label in order of creation. Geometrymay be used to create holes, pockets
and contours for toolpath.

Geometrymay be created using theGeometry Creation features of the system or imported from a
CAD program. Additionally, imported geometrymay bemodified. There are four methodswhen
using the system to create geometry:

• Free-formCAD

• Geometry Expert

• Combining Free-formCAD andGeometry Expert.

• Extracting geometry from a solid or sheet

This chapter details the different functions available for geometry creation and provides detailed
explanations of how shapes are created. To gain practical knowledge of the concepts outlined in
this chapter, complete the exercises provided throughout this guide.

Free-Form CAD
The free-formCAD tools included in the system are very powerful and easy to use. Creating points
and features is as easy as clicking on buttons and entering values. Likewise, connecting features to
form shapes that can bemachined simply involves selecting the intersecting features and clicking
on a button. Several different options are provided for creating points, lines, circles, curves, fillets
and chamfers, making it possible to create any shape regardless of how the blueprint is
dimensioned. The free-formCAD tools are particularly useful with parts requiring construction
geometry.

Geometry Expert
TheGeometry Expert is ameans of quickly creating geometry of simple parts and the simplified
creation of more complex parts. TheGeometry Expert is designed to create a single continuous
shape. It allows the user to define, create and connect shape featureswhile following along the
path of the part. The associative capabilities of the Geometry Expert make editing any existing
shape a very easy process.

TheGeometry Expert has a tabular format which operatesmuch like a standard spreadsheet.
Features are defined by entering data in cells of a row. Each row creates a different feature. The
rows define how the features are encountered along the shape path as if drawing a contour.
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Combination
Using both the Geometry Expert and the free-formCAD capabilities to create a part shape is a very
powerful combination. For example, a simple shaft with chamfers can be created in seconds by
using theGeometry Expert to create the horizontal and vertical lines, and the automatic
fillet/chamfer option in the Geometry Creation palette to create the chamfers.

Double-click any part of an existing 2D shape to load the geometry into the openGeometry Expert
table (except splines). All features of the shape are listed and dimensioned in the rows of the
spreadsheet where they can be checked and changed.

Extracting Geometry From Bodies
Geometrymay also be extracted from solids and sheets. Faces, edges and holesmay be extracted
from amodel. Additionally there is a tool that examines amodel and creates geometry for a parting
line for that model. A solid optionmust be available for these options to work.
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Working with Geometry
• Shapes and Connectors

• Points

• Features

• Making Connections

• Breaking Connections (Disconnecting)

• Geometry Context Menus

Shapes and Connectors
There are two types of shapes: open shapes and closed shapes. An open shape is a group of
connected features. There is a definite beginning and end to the shape. The two endsmay or may
not be terminated. A closed shape is a group of connected features in which there is no beginning
or end. A circle is themost simple example of a closed shape. Double-click a feature in a closed
shape to select all of the features and points in the shape.

Open Shape Closed Shape

There are two classifications of geometry used by the software – features and points. Lines, circles
and curves are considered features.

Points
A point has three states. It can either be a plain point, a connector point, or a terminator point.

• A plain point is used in constructing other geometry or for hole positioning. Plain points are
drawn in yellow and are round.

• A connector is used to connect two features together. It is drawn as a blue square.

• A terminator is used to end a shape. It is drawn as a yellow square.

Features
A feature is either a line or a circle. A feature also has three states: unconnected, connected but not
terminated, and connected and terminated. A feature can have amaximumof two connectors
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and/or terminators attached to it. When the second connection has been added to a feature, it will
change colors and become trimmed.

• Unconnected features are yellow. They are used either for constructing additional geometry or
can be connected to other geometry to form a shape to bemachined. Single features (one line
or one circle, for example) that are yellow can bemachined by the systemwithout being
connected to any other features or having any connection points.

• Connected (but not trimmed) features are features that have only one connection to another
feature. The feature will not be trimmed until a second connection is added or when it is
terminated. Since this type of geometry has only one connection, it will still be yellow.

• Connected and trimmed features are blue. They have been connected (or terminated) at both
ends. Since they already have two connections on them, no additional features can be
connected to them.

Making Connections

Most connections aremade automatically by the
software. If the Point button is chosen on theGeometry
Creation palette and two features on the screen are
selected, the software will automatically create a
connector at the intersection or tangency of the two
features. If a connection cannot bemade
automatically, a plain point will be created at the
intersection or tangency of the two features. Once a
feature has two connectors on it, it is considered fully
connected. A connectionmust be broken on the
original shape before another connection can be
added to it.

If a plain point exists at the intersection or tangent point between two yellow features, that point can
be turned into a connector. This is accomplished using the Connect-Disconnect button in the
Geometry Creation palette, which is described inmore detail in Connect/Disconnect , or youmay
use the right mousemenu to connect selected overlapping/tangent shapes. To change a point into
a connector, use the Ctrl key to select the point and the two features that intersect at the point.
These should be the only items that are selected. Click the Connect-Disconnect button. The point
will change to a blue square. If one (or both) of the features is already connected to another feature,
it will turn blue and trimwith a square yellow endpoint.

The four descriptions listed below explain possible reasonswhy the Connect-Disconnect button will
not perform the desired function.

• One of the features already has two connections on it.

• The point is not tangent to or is not exactly at the intersection of the two features.
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• The wrong geometry is selected, either toomuch or too little in most cases.

• There aremultiple features on top of one another.

The best way to tell if there aremultiple features on top of one another is to turn on View > Labels. If
all of the numbers are clearly visible, there is only one feature at that location. If the numbers are
jumbled, there are probably features on top of each other. Try deleting features and re-drawing until
there is only one feature left. If the last feature is deleted by accident, use the Undo item from the Edit
menu to back up a step. Refer to Cleanup in the Plug-insGuide for an alternate way to remedy this
issue.

Open Shapes

To terminate the last feature of a shape and create an open shape, a point needs to be created at
the location where the shape is to end. The feature to be terminatedmust be yellow to begin with.
Select the point and the feature and click the Connect-Disconnect button. The point will become a
yellow square. If the feature already has one connector or terminator on it, it will turn blue and trim.

Circles

When connecting circles, the shortest side of the circle will connect and the rest will be trimmed
away. To use the larger portion of the circle, select the circle after it has been trimmed and use the
Reverse Arc choice from theModifymenu. An alternate solution for circlesmay be created using the –
R function. See -R Creation.

Breaking Connections (Disconnecting)
It is sometimes necessary to break a connection. If the software automatically creates an undesired
connection or changes need to bemade to the original geometry, then the connection will need to
be broken. To break a connection, select the connector or terminator where the connection needs
to be broken and click the Connect-Disconnect button or use the right mousemenu
Connect/Disconnect option. The connector or terminator will turn into a regular round yellow point
and the connected featureswill turn yellow and extend to their original size. The features can then
be changed and reconnected to form a new shape.
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Geometry Context Menus

Right-click geometry to open a list of context menu
options:

• Connect/Disconnect

• Change to CS #

• Change Feature From "Wall" to "Air"

• Reverse Arc or Edit Spline

• Mouse Position

• Use Color and Use Color of Selected

• Show Properties and Show Properties of Selected

Connect / Disconnect
Available only when two or more items are selected. This option will connect any overlapping or
tangential geometric features. It works exactly the same as the Connect/Disconnect button. A
connecting point will be created if it is required; otherwise, if there is a point where the features are
to be connected, then that point will be used.When disconnecting geometry, youmust select either
the connecting point or select the features to be disconnected; you do not need to select the point
and features to disconnect them. For more information on the Connect/Disconnect button, see
“Connect/Disconnect ” on page 39.

Change to CS
This itemwill change the current coordinate system to the coordinate system of the right-clicked
geometry.

Change Feature from "Wall" to "Air"
(Also an item in the Properties dialogs.) Lets you designate the selected geometry as "Wall" or "Air".
Themenu itemwill always show which category the geometry can be changed to.

• Wall is the default setting for geometry. If default color settings are in effect, "Wall" geometry
displays blue.

• Air changes the behavior of geometry when setting upmachining operations. If default color
settings are in effect, "Air" geometry displays red.

"Air" geometry acts as a constraint similar to regular geometry, except that the toolpath will
overhang this area by the amount specified in themachining dialog. See theMill guide for
information regardingmachining with "Air" geometry andOverhang.

An additional use for "Air" geometry is in profiles for 2D Form tools. Geometry designated as "Air"
will become a non-cutting edge of the 2D Form tool.
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Reverse Arc
Available only if the item is an arc. This option will reverse the direction of the selected arc.

Edit Spline

Available only if the item is a spline curve. Opens the Edit Spline dialog, which lets you view and
optionallymodify the spline's knots (points that lie on the curve, shown in yellow) and control points
("shoulder" points, shown in red).

Controls in the Edit Spline dialog

• Button 1 prevents or allows modifications to the spline. When the spline is in "allow
modifications" mode, you can drag any knot or control point to see the effect on the overall
curve.

• Button 2 prevents or allows the addition of knot points.
To add a new knot point: Select the spline where you want the new knot point.
System response: The spline tightens: two new control points are added, and the two affected
previous control points approach the splinemore tightly.

• Button 3 prevents or allows the deletion of knot points.
To delete a knot point: Select it.
System response: The spline relaxes into the knots on either side of the deleted point.

• Button 4 prevents or allows the use of tangent features for modifying the spline. For a
feature to be used, it and the splinemust be connected. A user-specifiable angle value lets you
control the sensitivity.
System response: When you drag the spline's endpoint close enough to a candidate feature, a
gray phantom point will appear showing where a tangencywould be created. If you release the
mouse button during this time, the curve will "snap" to the phantom point and become tangent to
the feature.

Mouse Position
Opens the standardMouse Position dialog, just as if you had chosenmainmenu
View > Mouse Position. For information onMouse Position, see the CommonReference guide.

User Color
Opens a dialog that lets you assign user color to the right-clicked item. For information on user
color, see the Features guide.

User Color of Selected
Opens a dialog that lets you assign user colors to the selected items. All selected items appear in
the dialog, in a list that shows their workgroup, ID, and current color.

Geometry Properties
Opens a dialog that lets you view andmodify properties of the right-clicked item. For more
information, see “Geometry Properties” on page 16.
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Geometry Properties of Selected
Opens a dialog that lets you view andmodify properties of the selected items. For more information,
see “Geometry Properties” on page 16.

Geometry Properties
TheGeometry Properties dialog lets you view andmodify properties of a single element: a point,
line, circle/arc, or spline.

TheGeometry Properties of Selected dialog lets you view andmodify properties of all selected
elements (points, lines, circles/arcs, and splines), as follows.

Type
View only. Element type, such as point, line, arc (CW=clockwise, CCW=counterclockwise) or
spline.

ID
View only. The unique identifier for the element. Points have IDs of the formP<n>. Lines have
IDs of the form L<n>. Circles and arcs have IDs of the formC<n>. B-splines (free-form curves)
have IDs of the formB<n>.

WG
View only. The number and name of the workgroup that contains the element.

CS
The number and name of the coordinate system that contains the element.

Air/Wall
Elements other than points are designated either “Wall” or “Air”:

• Wall is the default setting for geometry. If default color settings are in effect, "Wall" geometry
displays blue.

• Air changes the behavior of geometry when setting upmachining operations. If default color
settings are in effect, "Air" geometry displays red.

"Air" geometry acts as a constraint similar to regular geometry, except that the toolpath will
overhang this area by the amount specified in themachining dialog. See theMill guide for
information regardingmachining with "Air" geometry andOverhang.

An additional use for "Air" geometry is in profiles for 2D Form tools. Geometry designated as "Air"
will become a non-cutting edge of the 2D Form tool.

Rapid / Feed
Lines can be designated either “Rapid” or “Feed”:

• Feed is the default setting, indicating that the tool will move at the speed specified for feedrate.
Lines designated as Feed display solid.

• Rapid indicates that the tool will move at the speed specified for Rapiding. Lines designated as
Rapid display dashed.
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Depth
when the Polar & Cylindrical Milling option is installed, a workgroup can be specified asRotary,
allowing geometry and toolpath to be wrapped about the C axis by rotary interpolation of the C
axis in milling operations. The Depth value allows you to specify a radius value for each element
in a Rotary workgroup. It takes effect only when the workgroup is in radial mode — that is, when
theWrapped checkbox is selected for its Part Geometry. For full information on Rotary
workgroups and radial mode, see theMill/Turn guide.

To modify geometry properties

1. Select one or more rows in the table of elements.

2. Select one or more option buttons of:

- Rapid or Feed

- Air orWall

- Not wrapped
(Or, to set all selected rows to a wrap depth, select theWrap Depth option button and enter
the radius value.)

3. Click Apply to Selected Items.

Geometry Palette Interface
TheGeometry Creation palette contains all of the text creation tools including free-formCAD tools
geometry from solids tools andGeometry Expert. The buttons in the palette access sub-palettes
and dialogs that allow the user to enter feature specifications and create shapes.

TheGeometry palette is where all forms of geometry are created. Sub-palettes create specific
types of geometry. The Connect/Disconnect button creates connections, terminators or
disconnects features. Geometry Expert allows geometry shapes and features to be defined quickly
with a table.

1. Point
2. Line
3. Circle
4. Shape

7. Geo FromSolids
8. Connect/Disconnect
9. Geometry Expert
10.Dialog controls
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5. Curve
6. Chamfer/Fillet

11.Workgroup Info (Level 1 only)
12.Workgroup list (Level 1 only)

Palette Shortcuts
All nine buttons in the Geometry Creation palette can be accessed from the keyboard by entering
the number of their position in the palette, 1 through 9. For example, type a (1) instead of clicking on
the Point button, a (2) for the Line button, a (3) for the Circle button etc.

Sub-Palettes
TheGeometry palette contains seven sub-palettes that create free-form points, lines, circles,
shapes, curves, fillets or chamfers and geometry from solid features. Once a sub-palette is open a
selectionmode is activated allowingmultiple items to be selected without requiring the Ctrl key to
be pressed.

Return
This button, contained in each sub-palette, will return to themain Geometry palette. Alternately you
may press the Esc keywithin any sub-palette.

Descriptor Points
Some geometry dialogswhich require point data have a P (Point) or CP (Center Point) button which
allows users to enter the point data directly into the line or circle geometry dialog.When a
Descriptor Point button is pressed, the geometry dialog extends so that coordinate for that point can
be input. Descriptor Points are not created, or drawn on the screen. In this way they don’t clutter the
workspace with points that would later become deleted. Descriptor Points are used when a current
point is not available to be selected for the particular geometry feature creation.

Dimension Labels
The dimension labels (XYZ) will vary depending on themachine type and/or Coordinate System.
For more information, see Coordinate Systems.

Single/Multiple Feature
When creating features some dialogs have two buttons. The single feature button will create the
feature and return to themain Geometry palette. Themultiple feature button will create the feature
and keep the dialog open to createmore of the same type of geometry. Press Enter to activate the
selected button, and pressing Shift+Enterwill activate theMultiple button.

Point creation Line creation Circle creation

Smart Selection and Inferred Features

When you open a sub-palette the system looks at any selected geometry. The system assumes that
you want to use the geometry that is selected to define a feature. If only one kind of feature can be
defined from the selected geometry the systemwill automatically take you to the dialog for that
feature type. There are variations on this, Smart Selections and Inferred Features.
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Smart Selection

A Smart Selection occurs when there is only one possible solution to the combination of selected
geometry and the feature type chosen. Think of this as a shortcut.

Example 1
If you have 2 points selected and you click on the Line button the systemwill take you to the Line
Between Two Points dialog with the point data already entered.

Example 2
If the same two points were selected and you clicked on the Circle button the systemwill take you to
the Radius and Two Points dialog.

Example 3
If three points are selected and you click the circle button then the system takes you to the Three
Features dialog.

Inferred Features

Inferred Features are solutions to creating geometry that do not have a dialog. These are features
tangent to two other features. Inferred Features include a point tangent to two features, a line
Tangent to a point and a circle, a line tangent to two circles, a circle tangent to two lines, a circle
tangent to two circles, a circle tangent to a line and a circle and a circle tangent to a line and a point.
Each of these items are fully detailed in Point Sub-Palette, Line Sub-Palette and Circle Sub-
Palette.

Point Sub-Palette
The Point sub-palette which contains a variety of options for creating points in 2D and 3D space.
Other options for creating points are available if features are selected prior to opening the Point
sub-palette.

1. Explicit
2. Polar Point
3. Bolt Circle
4. Matrix
5. Center Point

6. Mid-Point
7. Point On Arc
8. Mouse Point
9. Return button

Explicit
An Explicit point can be created by entering coordinate values for that point. Turning dialogswill
only contain two axis coordinates as shown. The P value can be used tomove existing points by
entering coordinates and the point label, for instance P21 and the creation buttonswill modify point
21 to the coordinates entered.
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Mill Turning

Polar Point
Creates a point at some angle (A) and distance (D) from an existing point (P) or specified
coordinates.

Bolt Circle

Creates a circular pattern of points. When the Full box is checked, the Degrees Between Points text
box is not available. In this case, the systemwill evenly space the given number of points to
complete the circle.

1. Radius of Circle Pattern
2. Z Depth of Points
3. # of Points in the Pattern
4. Y Coordinate of Pattern Center
Point

5. X Coordinate of Pattern Center
Point

6. Degrees Between Points
7. Angle to 1st Point

Matrix:
Creates a parallelogram pattern of points. When theOutline box is checked, the systemwill only
create the points that define the outline of the parallelogram.

1. X Coordinate of 1st Point
2. Y Coordinate of 1st Point
3. Z Depth of Points
4. Side 1 Change in X
5. Side 1 Change in Y
6. # of Points in Side 1
7. Side 2 Change in X
8. Side 2 Change in Y
9. # of Points in Side 2
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Center Point
Creates a point at the center of an existing circle. You can also do this function tomultiple selected
circles. When performing this action be sure you are in the Point Sub-Palette or the Center Point
dialog before selecting all the circles you want to make center points for. The Shift-Drag selection
workswith this feature. Please note that the dialog will still display only the first selected circle’s
label.

Mid-Point
This will create an unconnected point at themid-point of a selected line or arc.

Point on Arc
Creates a point along an arc. The radius of the arc and one other valuemust be entered to calculate
the point’s position. The variables other than the arc’s radius include the angle of the arc, the known
X coordinate of the point and the known Y coordinate of the point. There is a radio button to switch
between positive and negative Y values.

1. X Coordinate of a known point
2. Y Coordinate of a known point
3. Toggle Between Y+ and Y- value
4. Angle of Point on Arc
5. Radius of Arc
6. Center Point of Arc

Mouse Point
Create point using themouse. Click to create the points. Points will snap to the specified Grid. The
depth of the pointsmay be changed bymodifying the value in the Z box.
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Point Tangent to Two Features
This is an inferred feature. If two features (two lines, two circles or a line and a circle) are selected
and you click on the Point button the systemwill attempt to create a point wherever the features
intersect. If the features do not intersect or are not tangent nothing will happen otherwise you will be
prompted to choose the proper solution.

Line Sub-Palette
The Line sub-palette creates various types of lines. Lines can be created based on selections. Click
to view

1. Two points
2. Point Angle
3. Angle & Tangent
Circle

4. Parallel

5. Perpendicular
6. Axis
7. Mouse Line
8. Return button

Two Points
Creates a line through two points. The pointsmay already exist, or they can bemanually entered by
clicking on the P button(s).

Point Angle
Creates a line through an existing point at a specified angle. The point may already exist, or it can
bemanually entered by clicking on the P button.

Angle & Tangent Circle
Creates a line tangent to the selected circle at a specified angle.
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Parallel
Creates two parallel lines at a specified distance from the selected line.

Perpendicular
Creates a line perpendicular to a selected line through a specified point.

Axis
Creates a horizontal or vertical line parallel to an axis at a specified distance from the origin.

Mouse Line
Creates connected lines using themouse. Click to create endpoints. Points will snap to the
specified Grid. The Grid can bemodified while drawing lines aswell as the depth value. Lines can be
designated as Rapid geometry. Double-click to create a terminator point, or to exit the dialog.
Click the first point to close a shape.
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Line Tangent to a Point and a Circle
This is an inferred feature. When a point and a circle are selected and you click on the Line button,
the systemwill make a line that is tangent to the point and line. If the point and circle are coincident,
then the line will be tangent to the circle at the point; otherwise you will have to choose which the
proper solution for a line tangent to the circle through the point.

Line Tangent to Two Circles
This is an inferred feature. When two circles are selected and you click on the Line button the
systemwill make a line that is tangent to the circles. As there ismore than one possible solution, you
will be prompted to choose the line you need.

Circle Sub-Palette
TheCircle sub-palette contains options for the creating various circles

1. Radius & Center
Point

2. Point & Center Point
3. Radius & Two Points

4. Three Features

Radius & Center Point
Creates a circle using a selected point or entered coordinate value for the center point and a radius.
Youmay also create circles of the same diameter frommultiple selected points. To use this function
be sure to access the Circle Sub-Palette or the Radius & Center Point dialog before selecting the
points you wish to create circles around. The Shift-Drag selection workswith this feature. The
dialog will still only show the first selected point’s label but clicking the Create Circle button will
generate a circle around each point.

Center Point-Circumference
Creates a circle by selecting a point for the center point and another as a point on the circumference
of the circle. The center point may also be enteredmanually.
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Radius & Two Points
Creates a circle using a radius value and two tangent points to define the center point of the circle.
The pointsmay be selected or enteredmanually.

Three Features
Create a circle by selecting any combination of three points, lines or circles for the circle to intersect
or be tangent to.

Circle Tangent to Two Lines
This is an inferred feature. When two lines are selected you can create a circle tangent to the two
lines. You will be prompted to specify the circle’s radius. When determining the possible points of
tangency the length of the line is not considered; internally the system extends the lines out as far as
is needed to determine tangency. If the radius is too small to create tangency nothing will happen.
As there ismore than one possible solution you will be prompted to choose the line you need.

Circle Tangent to Two Circles
This is an inferred feature. When two circles are selected you can create a circle tangent to the two
circles. You will be prompted to specify the tangent circle’s radius. If the radius is too small to create
tangency nothing will happen. As there ismore than one possible solution you will be prompted to
choose the line you need.

Circle Tangent to a Line and a Circle
This is an inferred feature. When a line and a circle are selected you can create a circle tangent to
the two features. You will be prompted to specify the tangent circle’s radius. If the radius is too small
to be tangent to the features nothing will happen. As there ismore than one possible solution you
will be prompted to choose the line you need.

Circle Tangent to a Line and a Point
This is an inferred feature. When a line and a point are selected you can create a circle tangent to
the two features. You will be prompted to specify the tangent circle’s radius. If the radius is too small
to be tangent to the features nothing will happen. If the point and line are coincident the circle will be
tangent to the line at the point. There are two possible solutions to this tangency so you will be
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prompted to choose the circle you need. If the line and point are not coincident you will have to
choose which the proper solution.

Shape Sub-Palette
The Shape sub-palette can create various types of shapes including text, offset shapes, rectangles,
polygons, ellipses, gears and cams.

1. Text Creation
2. Offset
3. Rectangle
4. Polygon
5. Ellipse

6. Gear
7. Cam
8. Combine Shapes / Trim
Shapes

9. Return button

Text Creation

The Text Creation dialog creates spline geometry from any TrueType font and allows you to select
the typeface, text size, justification, position, text flow, spacing between characters, words and
lines.

Text Tab:
The specifications entered in this window establish what the text will look like and where it will be
positioned on the part.

Font List:

This is a list of all typefaces that are available to create the text. Only TrueType fonts (typefaces)
can be used to create geometry from text.

Text Size:
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This value specifies the height (measured in either inches or millimeters) of a capital ‘A’ in the
selected type face. All other characters will be sized proportionally.

Justification:

These buttons specify whether the text should be left-justified, centered or right-justified. If left
justified is selected, all text is aligned so the left edge of each line is in the same X location (or if
radial is selected, the same angle). If centered is selected, the center of each line of text is
calculated and the text is positioned so the centers all share the same X location or angle. If
right-justified is selected, the text is aligned so the right edge of each line is in the same X
location (or if radial is selected, the same angle). Justification will only have an effect if there is
more than one line of text. The longest line of text is used to specify the left or right edge. All text
is then aligned based on one of these locations.

Align. Pt. / Center Pt.:

The X, Y and Z values that will be used as the starting point for text creation. The text, Straight
or Radial, will be aligned at this point.

Straight Text Alignment:

Text can either be created in a straight line or along an arc. This is
designated in the Text Flow window which is described later in this section.
If straight text is created, a rectangular area that will contain the text is
used for positioning. The diagram specifies how the text will be positioned

within the rectangular text area based on the coordinates of the Alignment Point. For
example, if the position highlighted in the diagram shown above is selected, the text will be
positioned in the lower left corner of the rectangular text area at the Alignment Point. The
bottom of the text will be at the Y value of the Alignment Point and the left edge of the text will
be at the X value of the Alignment Point. Clicking on the circular position points selects the
different possible alignment locations.

Radial Text Alignment:

If text is created along an arc, a radial area that will contain the text is
used for positioning. The radial text area is created by entering an angle
value that specifies where along the arc the text will begin and a radius
that specifies the size of the arc. The Alignment Point coordinates
specify the center point of the arc. The diagram specifies how the text
will be positioned within the radial text area. Exampleswith the Radial

Text Alignment information and the resulting text are shown.

EXAMPLE 1: Inner Radius/Start on Angle:

The picture shows the text as well as the arc and line which designate the radial text area
and the starting location of the text. The position selected on the diagramwill create the
text along the outside of the circle beginning at the line specified by the Angle (the circle
and line are drawn only to better visualize the example).
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EXAMPLE 2: Center Radius/Center on Angle:

The picture shows the text as well as the arc and line which designate the radial text area
and the starting location of the text. The position selected on the diagramwill create the
text along the centerline of the circle and the center of the line of text will lie along the line
specified by the Angle.

EXAMPLE 3: Outer Radius/End on Angle:

The picture shows the text as well as the arc and line which designate the radial text area
and the starting location of the text. The position selected on the diagramwill create the
text along the inside of the circle ending at the line specified by the Angle.

Spacing Tab:
These options allow you to enter distance between letters, between words, and between lines of
the text. Values entered in this window will be added to or subtracted from the standard spacing.
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Text Flow Tab:
This section designates the text flow, line flow and shape of the text.

Text:

Text can either be created horizontally or vertically. The first two buttons create text (characters)
that will flow along a horizontal line, either from left to right (right arrow) or right to left (left
arrow). The last two buttonswill make the text flow along a vertical line, either from bottom to top
(up arrow) or from top to bottom (down arrow).

Shapes:

These buttons designate whether the text will be created in a straight line or on an arc (these
buttonswill change in appearance when creating vertical lines of text, but their functionality
remains the same). The first button will make the text flow along the arc specified in the Text tab
window in a clockwise direction. Themiddle button creates text in a straight line, and the third
button creates text on an arc in a counter-clockwise direction. The selectionmade for Shapes will
affect the Alignment Diagrams in the Text tab window.

Lines:

These buttons only have an effect if multiple lines of text are being created (these buttonswill
change in appearance when creating vertical lines of text, but their functionality remains the
same). The first button specifies that the lines flow from bottom to top for horizontal lines of text
or from left to right for vertical lines. The second button specifies that horizontal lines of text flow
from top to bottom or vertical lines flow from right to left.

Aswith many other Shape dialogs, the lower left corner provides a button:  Mouse Shape lets you
create shapeswith a quick click-slide-click: Click to anchor, slide to get a ghosted preview, and
then click to create the shape.

Offset

The ShapeOffset dialog allows shapes to be offset by a specified distance. Two offset shapeswill
be created. Offset shapeswill adjust to the exact distance entered by a radius, so fillets and corners
are added to the offset geometry as illustrated in the image. (To prevent automatic fillets and
corners, select Square Corners.) The Accuracy value affects splines only.
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Aswith many other Shape dialogs, the lower left corner provides a button:  Mouse Shape lets you
create shapeswith a quick click-slide-click: Click to anchor, slide to get a ghosted preview, and
then click to create the shape.

Rectangle

TheRectangle dialog creates rectangles and squares and can automatically add Fillet Radius
corners. Define the total length of each side of the rectangle for X and Y, the Start Position of the
rectangle by entering the X, Y, and Z coordinates, and click the position on the rectangle to use for

the Start Position as the center point, an edgemidpoint, or a corner point.

Aswith many other Shape dialogs, the lower left corner provides a button:  Mouse Shape lets you
create shapeswith a quick click-slide-click: Click to anchor, slide to get a ghosted preview, and
then click to create the shape.
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Polygon

The Polygon dialog createsmulti-sided shapes (polygons). Specify the number of Sides, the Center
Position, the Distance To Flat or Distance To Corner. There is also a checkboxwhich allows the user to
specify a Fillet Radius on each corner of the shape.

Aswith many other Shape dialogs, the lower left corner provides a button:  Mouse Shape lets you
create shapeswith a quick click-slide-click: Click to anchor, slide to get a ghosted preview, and
then click to create the shape.

Ellipse
The Ellipse dialog creates vertical and horizontal spline ellipses. Enter the X and YRadius, and the
Center Position. A larger X value creates an horizontal ellipse while a larger Y value creates a vertical
ellipse.

Aswith many other Shape dialogs, the lower left corner provides a button:  Mouse Shape lets you
create shapeswith a quick click-slide-click: Click to anchor, slide to get a ghosted preview, and
then click to create the shape.
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Gear

TheGear dialog creates complex gears by defining a single tooth of the gear. UsingModify >
Duplicate And... > 2D Rotate to create the rest of the gear. For more information about creating gears,
see theGeometry Creation tutorial.

1. Addendum / Major Diameter
2. Dedendum / Minor Diameter
3. Top Fillet
4. Root Fillet
5. Diametral Pitch
6. Circular Pitch
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Gear Definition

TheMachinery's Handbook is an excellent source for information onGearing. All of the
calculations and formulas are based on this information (ANSI standard B6.1-1968).

Pressure Angle
The angle between the top of the tooth and the point of intersection between the tooth and its Pitch
Diameter. SelectOther to specify a different value.

Addendum / Major Diameter
The radial distance between the pitch circle and the top of the tooth. Changing the gear type from
Gear to Spline changes Addendum toMajor Diameter.

Dedendum / Minor Diameter
The radial distance between the pitch circle and the bottom of the tooth. Changing the gear type
from Gear to Spline changesDedendum toMinor Diameter.

Top Fillet
The convex portion of the tooth where it joins the top of the tooth.

Root Fillet
The concave portion of the tooth where it joins the bottom of the tooth.

Calculate
The values for Addendum and Dedendum (or, whenGear Type is Spline, forMajor Diameter andMinor
Diameter) and values for Top Fillet and Root Fillet can be calculated from the Pressure Angle, Pitch
diameter, Diametral Pitch, Circular Pitch and Full # Teeth.
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Orientation
Specifies whether the gear is internal or external.

Diametral Pitch
This is the ratio between the number of teeth and the number of inches/mmof pitch. This value can
be used to Calculate the other dependent values for the gear.

Circular Pitch
The length of the arc of the pitch circle between the center and adjacent teeth. This value can be
used to Calculate the other dependent values for the gear.

Pitch Diameter
The diameter of the pitch circle. This value can be used to Calculate the other dependent values for
the gear.

Full # Teeth
The number of teeth that a gear will contain. This value will be automatically created from the
Diametral Pitch and Pitch Diameter values entered. Remember, although that the full gear is not
created until the user creates the teeth with the Duplicate And... feature. The Full # Teeth valueminus
one will be entered into the Duplicate And... text box for full gear creation.

Space Width / Tooth Width
Circular thickness: Space Width for Internal orientation, or ToothWidth for External orientation. It
describes the space between the teeth of the gear. The Basic value is calculated for users based
upon other defined specifications of the gear; however, you can bypass this value by defining your
own value in the Desired text box. The value is calculated to a Basic or zero slope value. A tooth can
be narrowed or a space can be enlarged depending on the gear to be defined.

Involute Curve
A profile of one side of a gear tooth. The systemwill translate this data into a cubic spline which is
more readilymachined, because an involute curve cannot be directly interpolated by a CNC.

Sample Points
The number of points along the gear's Involute Curve to take into consideration when calculating
the spline.

Tolerance
How close to the Sample Points the splinemust pass.

The systemwill very closely approximate the Involute Curvewith the default values, but tighter
tolerancesmay be used if needed. Notice that this is independent ofMachining Preference: To
hold a 0.001" Tolerance to the Involute Curve, use a Tolerance of 0.0005" in the gear creation dialog
and a Tolerance of 0.0005" in theMachining Preference.

Gear Type
Select the type of gear to be created.

Cam

This dialog helps you create the geometry for cams.



Working with Geometry

35

Motion Type:
This selection will determine the shape of the cam. Depending on the need of the user., themotion
typemay be selected from Uniform Velocity, Harmonic, Cycloid, orModified Sine.

Tolerance:
This is the greatest distance allowed between the points on the cam and the arcs generated to
approximate the best possible cam. In general, a large value here creates fewer arcs, but the
deviation between the desired shape and the created shape is large. A small value should result in
amore accurate shape with significantlymore arcs.

Start Radius:
This is the smallest circle drawn to the cam shape. It is also commonly referred to as the Base
Circle.

End Radius:
This is the largest circle that the cam shape will be drawn to.

Start Angle:
This is the angle fromwhich themotion of the camwill begin.

End Angle:
The angle at which themotion will end.

CW / CCW:
This selection will dictate the direction of themotion from the Start Angle to the End Angle, either
clockwise (CW) or counter clockwise (CCW).

Combine Shapes / Trim Shapes

This geometry palette lets youmanipulate shapes as regions that can be combined, trimmed, or
broken into segments. Simple examples are shown in sample parts Geometry_Shape*.vnc, and
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use cases are illustrated in the workgroups of sample part Geometry Region Function
Palette.vnc.

Shape Union

Creates the smallest shape that includes all selected regions, selected in any order.

Shape Subtraction

Starting from the first-selected region, subtracts the next-selected region or regions.

Shape Intersection

Creates the largest shape that is shared in common by all selected regions, selected in any order.

Trim Shapes In

Snips off outer geometry and/or regions from elements containing portions that lie outside the
region. If two or more regions are in the selection set, elements/regions are trimmed against the
largest region.

Trim Shapes Out

Snips away inner geometry and/or regions from elements containing portions that lie inside the
selected region. If two or more regions are in the selection set, elements/regions are trimmed
against the first-selected region.

Slice Shapes

Breaks overlapping elements in the selection set, creating separate elements so that none overlap.

Each of the Combine / Trim functions adds terminator points wherever needed.

Sample part:
“Geometry_Shape_
Combine.vnc”

Union Subtraction Intersection
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Sample part:
“Geometry_Shape_

Trim.vnc”
Trim Shapes In Trim ShapesOut Slice Shapes

Curve Sub-Palette
TheCurve sub-palette which provides threemethods for creating curves through a series of pre-
points. The curve will travel through the points in the order theywere selected.Modify > Sort can be
used to sort the points in the correct order to create the desired curve. After the curve is created,
you can right-click it and use Edit Spline tomodify it.

1. Line Fit button
2. Curve Fit button
3. Control Point button
4. Tolerance setting

5. Close Shape checkbox
6. BlendingMethodmenu
7. Do It button
8. Return button

Line Fit
Thismethod creates straight lines between the selected points. If a Tolerance is specified, any points
that are co-linear within the specified tolerance will be approximated by a single line, rather than
several small lines between the points. If Close Shape is turned on, the systemwill create a closed
shape, meaning that the first and last lineswill be connected. The BlendingMethod pop-upmenu is
not applicable when using the Line Fit method.

Curve Fit
Thismethod creates a B-Spline curve through the selected points. The Tolerance value is designed
to reduce themathematical complexity of the finished curve and should only be larger than 0.00
when generating curves from a large number of points. When a 0.00 tolerance is used, the system
will create a smooth curve that passes through every selected point. When a value larger than 0 is
used, the system uses a different method to produce the curve, and any points that lie within the
Tolerance specified will be skipped. Even if no points lie inside the Tolerance, a completely different
curve will be generated by the system than if a 0.00 Tolerancewas used. The curve generated by
zero Tolerancewill be smoother than a curve generated by a non-zero Tolerance.

Control Point
Thismethod produces a B-spline curve using the selected points as control points. When using
control points, only the first and last point must actually lie on the curve. The other points are used to
specify the shape and direction of the curve. The Close Shape, Tolerance and BlendingMethod
specifications are not applicable when using the Control Point method.

Close Shape
This will create a closed, continuous shape.
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Blending Methods
The blendingmethods control how the curve will be approximated through
the selected group of points. There are an infinite number of possible curves
that can be drawn between a series of points. The way the curve is
calculated between the points is based on the blendingmethod. There are
four options for the BlendingMethod. They are Chord Length, Uniform, Foley’s

and Centripetal. One way to explain the differences between these blendingmethods is to imagine a
point traveling along the curve being created. The difference betweenmethods is how much time
the point spends traveling along the curve between the points that define the curve. The Chord
Length and Uniformmethods are general curve calculationmethods. The Foley’s and Centripetal
methods are based on the Chord Length and Uniformmethods and attempt to create a closer
approximation of the desired curve. Each blendingmethod is described below.

Chord Length Uniform Foley’s Centripetal

Chord Length
Thismethod creates a curve between points proportional to the distance between points. That
is, the farther apart two points are, the “longer time” it spends traveling between them, which is
why it createswider curves. The closer two points are together, themore the curve flattens out,
because “less time” is spent traveling between the points.

Uniform
Thismethod attempts to create curves of equal length between points of equal distance from
each other.

Foley's
Thismethod takes into account the angle between adjacent points. The larger the angle, the
“more time” is spent between the points, causing the curve to be less pointed than the Uniform
method.

Centripetal
Thismethod is based on the Chord Lengthmethod. It uses the calculated square root of the
Chord Lengthmethod to blend the curve between the selected points. Thismakes for a slimmer
curve.

For information on Edit Spline functionality, an option on the right mousemenu, see “Geometry
Context Menus” on page 14.

Chamfer and Fillet Sub-Palette
TheChamfer-Fillet sub-palette provides options for creating fillets and chamfers. This sub-palette is
only accessible when one or more points are selected. The options available in this palette will only
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work on fully-connected points. Multiple fillets and chamfers can be created at one time by using this
option whenmultiple points are selected.

1. Fillet button
2. Chamfer-Side
3. Chamfer-Depth
4. Chamfer-Length

5. Createmultiple
chamfer/fillets

6. Create single
chamfer/fillet

7. Return button

Fillet button
Creates a fillet for selected connector points.

Chamfer-Side
Creates a chamfer based on a side value for selected connector points. Geometry Expert uses this
type of Chamfer.

Chamfer-Depth
Creates a chamfer based on a depth value for selected connector points.

Chamfer-Length
Creates a chamfer based on a length value for selected connector points.

Multiple chamfers
Select one or multiple points to apply a chamfer/fillet, click this button to apply, dialog remains open.

Single chamfer/fillet
Select one or multiple points to apply a chamfer/fillet, click this button to apply. Dialog closes.

Return button
Return to previous level.

Connect/Disconnect
TheConnect/Disconnect button is used to connect, disconnect and terminate geometry. It
becomes available when either a point is selected or two intersecting/tangent features are selected,
(this feature can also be accessed by pressing the 8 key on the keyboard). To connect geometry
simply click this button.

Clicking on the Connect/Disconnect button will:

• Connect or disconnect tangent or intersecting geometry. The systemwill attempt to use an
existing point at the intersection or tangency to connect features otherwise it will create a new
point to connect the features. Refer to the Shapes and Connectors section in this chapter for
details.

• Terminate or unterminate open shapes.

A point may have three states:

• Unconnected (the point is yellow and round).
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• Being used as a connector between geometry features (the point is a blue square).

• Connected to geometry and being used as a terminator (the point is a yellow square).

Multiple Connections

When connecting geometry that hasmultiple solutions, as with connecting a line to a circle, the
Point Selection dialog will appear. The Point Selection dialog asks for the correct connection point
(s) to be selected. Youmay select one or more intersection points. If only one intersection is
available, the systemwill disable the other connection possibilities. Press theOK button after
selecting the intersection to create the connection. Press the Esc key to cancel any connections.

Overlapping Connections

If the Point Selection dialog comes up when creating a connection but no points are visible, the
pointsmay be too close together to be displayed. You need to zoom in to reveal the points. This will
generally happen with connections tangent to a circle. The following image illustrates two tangent
points available in connecting two features. The line actually has two tangent points so close
together that the points overlap and become invisible.

An example of a possible connection that cannot be seen (left), and the
points after zooming in (right)

Sometimes connecting points cannot be displayed, such aswhen they are in the same
horizontal and vertical position but at a different depth and the view is looking down the depth

axis. When the possible connections are overlapping the system displays the cross hair as shown.
Simply change the view orientation until the points become visible.
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After rotating the geometry, the hidden connection points are
revealed

Geometry From Solids Sub-palette
TheGeometry fromSolids sub-palette contains options for extracting edges and holes from solid
models.

1. Geometry
Extraction

2. Hole Extraction

3. Parting Line
4. Outline
5. Return button

Geometry Extraction

The geometry extraction function creates geometry from both edges and faces of solids and sheets.
Your selection can include both edges and faces, i.e. a combination of both edges and faces are
selected on a body. In order to view edges of a solid or sheet, the systemmust be in Edge Selection
mode. Connected shapeswill be created if the selected edges create a closed loop. Clicking on the
Do It button in the Geometry Extraction dialog will create geometry from any selected edges or faces
(in Face Selectionmode).
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Typically, this function will extract the selected edges as splines or curves. However, if the resulting
spline edge can be converted to lines or circles within the specified tolerance, the extracted
geometry will consist of lines and circles. The Geometry Extraction dialog allows users to enter a
tolerance value which will be used to determine whether or not the selected edgeswill approximate
lines and circles within the given tolerance. A large tolerance value will convert more of the edge
splines to lines and circles, while a tight tolerance will keep the entities as they are defined in the
part model. A tolerance of zero is recommendedwhen extracting geometry that is definitely a circle
or a line.

Hole Extraction

This function is used to create circles from holes in solids or sheets. This is very useful when a
model contains drill holes. In order to create a drilling operation, points or circlesmust be selected.
This function allows the user to extract circles from the existing holes on amodel in order to have
geometry to select for drilling operations.

When using this function, either a solid or sheet can be selected and the systemwill scan the faces
of the selection and find all holes. A holemust have walls which are perpendicular to the current
CS. Additionally, the edge loop of the holemust be either a circle or a spline — it cannot be a polyline
(line segments approximating a circle). When hole extraction is performed, the resulting geometry
will all be circles. Any hole edge loopswhich are splines but fall within the Circularity Tolerance
specified will be extracted as circles. Edge loopswhich are splines that do not approximate a circle
within the given tolerance will not be extracted. The depth of the extracted geometry will be based
on the bottom of the hole(s), making it easy for the user to determine the depth for the drilling
operation.

Parting Line

This function creates a parting line curve from selected faces or bodies. The parting line curve is
generated where a face’s surface normals are parallel to the current coordinate system but not on
an edge. Think of this as a unique point on a face where the normals transition to and across
parallel to the CS. This parting line curve can be used to help create a parting line surface. This
function will not work onmany shapes, such as cubes. A cube has an infinite number of points
where surface normals are parallel to the CS. There are other tools in the system that may be used
to get the boundary of shapes such as a cube.
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A cube showingmany parallel normals and a sphere showing normals (in red) that provide
a unique solution

As previously stated, this function can be used to help you create a parting line surface — which is
the surface along which amold pulls apart. Typically, a mold is pulled apart into two pieces, either
two cavities or a cavity and a core. These two piecesmust match and seal perfectly along the
parting line surface in order for themold to produce the desired part. With simplemolds, the parting
line is often a simple plane through themiddle of the part. However, there aremore complex
situationswhere a planar parting line will not work.

Before using this function your model should be fully prepared for making amoldmodel, including
adding any draft angles. To use this function, select all the faces that the parting line will be on or
select the entire solid. The parting line function uses the depth axis of the current coordinate system
as the draw axis — the axis on which themold will be pulled apart. The parting line curve is the curve
on which the surface normal vector is parallel to the coordinate system (or normal to the draw axis)
at every point. The parting line function creates geometry which can then be used to create a
parting line surface.

A good way to create a parting line surface from parting line geometry is to sweep a straight line
along the parting line geometry, creating a sheet which will intersect the solid. The straight line is the
drive curve and should intersect and slightly overlap the parting line geometry which is the base
curve. Once the parting line surface is created, the part model can be subtracted from a cube to
create themold and then sliced with the parting line surface to create the two halves of themold.
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1. Original model
2. Parting Line geometry is
created

3. A sheet is swept about
the parting line geometry

4. Themoldmodel ismade
using the swept shape

Outline

This function will create geometry that is an outline of the selected faces on single or multiple solids
and/or sheets. The geometry is created at a depth of 0 in the current CS. This is useful for getting a
profile of a shape where edges are not easily selected or available, where youmaywant the profile
of a shape for an extrusion or to get the profile of a selected area for solid machining.

Geometry Expert
TheGeometry Expert button opens theGeometry Expert dialog which looks and acts verymuch
like a spreadsheet. Geometry Expert allows the user to create connected shapes by entering
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feature dimensions in the rows of the spreadsheet. This feature is fully detailed in Geometry Expert
Interface.

Geometry Expert Interface
Creating a shape using theGeometry Expert is analogous to contouring a shape, indicating such
items as location, direction and the distance being traveled. As the shape is created, geometric
contour logic principles are followed to allow automatically connect and assume logical geometric
shapes to require the least amount of input from the user. TheGeometry Expert, as its name
implies, provides the user with a built-in consultant on the rules and principles of geometry.

TheGeometry Expert is a very powerful editing tool. Feature dimensions can be adjusted by simply
changing the values in the cells. Geometry Expert handles all of the calculations and adjustments to
the other features that are affected by the changes.

• How Geometry Expert Works

• Creating ShapesUsingGeometry Expert

• Geometry Expert Table

• Additional Information

• -R Creation

How Geometry Expert Works
Geometry Expert is set upmuch like a standard spreadsheet. Feature specifications are entered
into cells which are contained in rows. Each row of the spreadsheet defines a feature.

1. Feature Row
2. Cell
3. Scroll Bar

Row Border Color
The current row is outlined in either yellow or black. Yellow indicates the row contains adequate
information. Black indicates the row does not contain enough information to define geometry. The
prompt at the bottomwill indicate the status of the row and define what is needed or what will be
created from the current data.
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Creating Shapes Using Geometry Expert
When creating a part using Geometry Expert, the first thing that must be decided is the starting
feature and the direction to travel around the part—either clockwise or counter-clockwise. Features
are defined in the order that they appear along the path of the shape. This process continues until
the last feature of the shape intersect the first feature of the shape or end points are defined. If the
shape is a closed shape the last feature row will be the Close Shape feature type.

Creating Features

When a row contains enough information to define the feature press the Enter key. The next row
will be highlighted and the feature typemay change or the Angle/Rad will switch based on the last
row.

Feature Types

There are several feature types including lines, circles, fillets, chamfers, and post. Each feature is
selected by changing the feature type button in the first cell of the row. For arcs, the selected feature
type indicates the direction—either clockwise or counter-clockwise. For lines, the angle value also
indicates the direction. For example, a horizontal line can either be defined with an angle value of 0°
or 180°; both will draw the same line, but in opposite directions.

Fillets, Chamfers and tangent arcs will be draw when the features surrounding them are completely
defined. These are called “floating features”. When the feature is created a reference number (Ref)
such as L1 (line 1) or C4 (circle 4) is entered in the row. This is the actual geometry’s label (View >
Labels).

In some cases, no information is required for the feature to be defined and the row will be yellow.
This is because it is still possible to add information in subsequent rows that will fully define the
feature. For example, a circle with a start point defined using a previous features end point and
tangent to the following feature.

Geometry Expert Table
TheGeometry Expert allows the user to create connected shapes by entering feature dimensions
in the rows of the spreadsheet.
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1. Current Row/Cell
2. Feature Type
3. Prompt
4. Reference #
5. Horizontal Endpoint

6. Vertical Endpoint
7. Line Angle/Arc Radius
8. Chamfer Side or Line Length
9. Horizontal Line point or Center Point
10.Vertical Line point or center point

Feature Type
There are six options available for the feature type. They are: Line (1), Chamfer (2), Fillet (3),
Clockwise Arc (4), Counter-clockwise Arc (5), and Close Shape (6). Each row must have a feature
type selected. To select the feature type, click the feature type button which will access the possible
selections. Drag themouse to the desired feature so that the button appears depressed, and let go
of themouse button. That feature will now appear as the feature type for that row. In some cases,
depending on the previous feature, some of the feature type optionsmay be disabled to indicate
that they are not valid selections. Also, depending on the feature type selected, some cellsmay be
disabled, indicating that the selected feature type does not require that dimension. The feature type
can also be selected using Alt+ the corresponding number.

Ref
This is the feature’s reference number. The letter indicateswhat type of feature it is (L for line, C for
circle) and the number indicates the creation order. Also displayed with View > Labels. These
reference numbersmay change during the course of geometry creation but will not affect the
shape.

EP (H)
The horizontal endpoint of the feature. When a feature is defined with an endpoint, the systemwill
draw the feature and trim it at the specified endpoint. Endpoint specifications are required if the next
feature needs a start point in order to be correctly defined.

EP (V)
The vertical endpoint of the feature.

Example
The row shownwill create a 140° line with an endpoint drawn at Xr 1.651. The next feature that
is defined in the spreadsheet will start at the endpoint of this feature.

Angle/Rad
The number entered in this cell is dependent on the feature type selected. If the feature type is a
line, this number specifies the angle of the line. The angle value for a line defaults to either 90°/270°
or 0°/180°, allowing for the creation of vertical or horizontal lines. The system toggles between
these angle values, whichmakes the creation of intersecting horizontal and vertical lines a very
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quick and easy process. The user can change the default values by simply entering the new
numbers in the cells. If the feature type is a arc or fillet, this number specifies the radius.

Example
This row will create a fillet between the previous and next feature with a radius of 0.28.

Length
The line length or chamfer side height.

LP/CP (H)
The horizontal line point or center point. A line point is any point tangent to the line.

LP/CP (V)
The vertical line point or center point.

Example
This row will create a 90° line at X4.When defining either horizontal (0°/180°) or vertical
(90°/270°) lines, only one LP coordinate is required. Refer to the section on Half Points in this
chapter for more information.

Example
This row will create a circle with a radius of 2 and a center point at X2, Y3.

Prompt:
The information contained in the prompt indicates the status of the current row. The prompt also
indicates if the system has automatically deleted a cell value because the feature row contained too
much information that overdefined the feature. This aspect of Geometry Expert is referred to as the
Auto Delete function, which is explained in the Expert Aids section of this chapter.

Close
WhenGeometry Expert is closed, all information is cleared.
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Expert Aids

There are several items built into Geometry Expert that are designed to guide the user through
geometry creation. They include Prompting, Auto Delete, and Error Balloons.

Prompting

The Prompting information appears across the bottom of Geometry Expert. The prompt tells the
user what actions are being taken by the system based on the information provided by the user.
The user should be able to follow the prompts through the creation process to get a good idea of
what is happening.

Auto Delete

The Auto Delete function of Geometry Expert is intended to reduce errors resulting from features
being overdefined because toomuch information has been entered into the feature row. Geometry
Expert is designed so that the user needs only to enter theminimumamount of information to define
a feature. The systemwill automatically delete the first entrymade in the feature row when the
feature is overdefined. Auto Delete is necessary in order to facilitate the associative capabilities of
Geometry Expert. Note that the default values, such as the line angle, are considered the first entry
rather than any information entered by the user. The prompt will indicate what information is being
deleted.

Error Balloons

Geometry Expert also contains Error Balloonswhich appear on the screen whenever a problem
occurs. Themost common error messages appear when the system requiresmore information for
a feature being entered. For example, if a line needs another value for an endpoint, an Error
Balloon will come up indicating that a V or H value is needed to calculate the endpoint. The Error
Balloons use the letters V and H (Vertical and Horizontal) rather than X and Y (for Mill) or Xd/Xr and
Z (for Turning.) This way the error messages remain the same regardless of what module is being
used.

Another common error message indicates that the feature being defined cannot intersect with the
previous feature. The non-intersecting feature can still be created, but themessage indicates to the
user that the continuity of the shape has been broken and subsequent features created will not
connect to the existing shape.

Additional Information

Defaults

Geometry Expert has defaults for the feature type and line angle. The standard feature type default
is a line. WhenGeometry Expert defaults to a line, it also enters an angle value, either 90°/270° or
0°/180°, depending on the angle of the last line entered. Sometimes a line is not a possible feature
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type option, in which case the system defaults to an arc. This only occurs when the previous feature
is a floating line. Geometry Expert dimensions the line according the preceding and subsequent
feature specifications. Floating features are not drawn on the screen until the system contains the
necessary information.

Point Selection

Despite all of its expertise, Geometry Expert can’t always know the correct intersection point to use
for a connector. When there are two or more equally valid points of intersection, the systemwill
draw both points and the point selection dialog will ask to select the appropriate point. Once the
user has selected the desired intersection point, Geometry Expert will make the appropriate
connection and continue along in the spreadsheet.

Half Points

In some cases, only one coordinate (either the horizontal or the vertical) is required to define the
feature. This is referred to as a half point case. Half points are valid whenGeometry Expert is able
to calculate the other half of the coordinate value from information contained in the spreadsheet.

When a valid half point is entered, the row will be highlighted in yellow, allowing the user to enter the
feature row. If the half point entered is not valid, the row will be highlighted in black and the prompt
will indicate what additional information is necessary to enter the row. If an incomplete row is
entered, an Error Balloon will come up indicating what additional information is required. There are
three caseswhere half points are valid. They are listed and explained below.

Half Line Point
A half line point is valid only when creating either a horizontal line (angle value = 0° or 180°) or
vertical line (angle value = 90° or 270°). If creating a horizontal line, a Y coordinatemust be given
for a valid half line point. If creating a vertical line, an H coordinatemust be given for a valid half line
point. Line points are not part of the shape, but are only used to calculate the position of the line.

Half End Point
A half end point is only valid if the line is otherwise completely defined. Given either the vertical or
horizontal coordinate of the end point along with the other information that defines the line, the
system can calculate the other half of the end point. If a half end point is used in the case of 0°/180°
or 90°/270° lines, the half end point will function like a half line point, in that an end point will not be
drawn, although the correct line will be created.

Half Center Point
A half center point is valid when a circle has a radius value and is tangent to the preceding feature.
(Theremust be a preceding feature.) Given the radius and the vertical or horizontal component of
the center point, the system can calculate the other half of the center point by the assumed
tangencies.

Floating Features

Floating features are featureswhose defining row does not contain all of the information necessary
to draw the feature. Floating feature rows are different from incomplete feature rows.With floating
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feature rows, the information contained in the current feature row and the preceding rows is
inadequate to completely define the feature and draw it. However, subsequent features should
provide the necessary information to define the floating feature. Floating feature rows are outlined
in yellow, indicating that the row has enough information to proceed.

Incomplete feature rows do not contain enough information to create the feature, and no amount of
information entered in the following rowswill make the feature definable. Incomplete feature rows
are outlined in black and indicate that more information is needed for a valid feature.

Inserting and Deleting Rows

Choose Edit> Insert row to insert a row into the Geometry Expert. New rows are created above the
selected row.When an inserted row is entered, the systemwill recalculate the shape and attempt to
incorporate the new feature into the existing shape, if possible.

Choose Edit > Delete Row to delete a row. Only rowswith created geometry can be deleted.
Deleting rows can also be done with the keystroke Alt+K.

Arcs vs. Fillets

Arcswith only a radius value and fillets appear to be very similar at first glance, but actually use two
completely different methods for calculating the circles. A fillet takes a sharp point produced by an
intersection between two other features and changes it into a radius. It is created after the
intersection between the two features is completed. Because of this, it is dependent on the
intersection of the other two features to exist. Thismeans that the system cannot use the fillet to
calculate features that follow it in the spreadsheet. Fillets are not used to calculate the features that
surround it.

An arc with only a radius value is created tangent to two other features. These two features do not
have to intersect. The arc is treated as an actual feature and can be used when calculating other
features of the shape.

This is particularly important when dealing with floating lines (lineswith limited information) that
have specific tangency requirements. Geometry Expert assumes that floating lines are going to be
made tangent to the preceding feature. In most cases this is adequate, but sometimes a floating line
is supposed to intersect the previous circle and be tangent to the next circle. This is called a
“forward” tangency.

In the case of forward tangencies, if there is a radius between the previous circle and the floating
line, then an arc (rather than a fillet) must be used to allow for the necessary tangency calculation.
The line will bemade tangent to both the arc used as a fillet and the next arc. A fillet cannot be used
in this case because the fillet will be ignored by the system until the intersection is completed, and
the correct intersection cannot be created without the arc. If there is no fillet, an arc with a radius of
zero will need to be created. This will allow the system to create the line tangent to the following
circle, while creating a sharp point at the intersection of the previous feature. For a practical
example of forward tangencies, refer to the Geometry Creation tutorial.
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-R Creation
Geometry Expert has –R (large arc) functionality that provides the ability to toggle between two
possible solutions for an arc between two features. This is completely different from the Reverse Arc
(Ctrl+T) feature, which changes the direction of the arc. -R provides access to opposite tangent
points on the circle. Normally the smaller radius will be used when creating geometry, -R offers a
way to override that default. These featuresmay be created in Geometry Expert or via free-form
CAD. Figure 5 below illustrates the difference between Reverse Arc and -R.

1. Clockwise
2. Counter Clockwise
3. Default Arc with R
4. Reversed Arc
5. Default Arc with -R
6. Reversed Arc with -R

Via Geometry Expert

When usingGeometry Expert the –R functionmay be applied to an arc defined in one of two ways.
First, the arcmay be defined by being tangent to the previous feature (a line or arc) and a specific
endpoint. Second, the arcmay be defined by a radius and an endpoint, and the feature previous to
the arcmust be defined by an endpoint. The previous featuremay be a line or an arc. To apply the –
R functionality simply place a “–” (minus sign) before the arc’s radius. Figure 6 provides an example
of this.

Via Free-Form CAD

Geometry created by standard CAD functions (free-formCAD) may be loaded into Geometry
Expert andmodified to a use the larger arc solution. For this to work, the free-form arcmust be an
arc that is tangent to a previous feature (line or arc) and a given end point. To apply the –R
functionality, simply place a “–” (minus sign) before the arc’s radius once the geometry has been
loaded into Geometry Expert.
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1. Example of an arc
defined by a radius
and endpoint with a
previous feature
defined by an end
point.

2. Example of an arc
defined by a radius
and endpoint that is
tangent to the
previous feature.

Examples of –R use in Geometry Expert

Dimensioning
TheDimensions palette is accessed from the View > Dimensions Palette or from theMain palette in
the Level 2 interface. The Dimensioning tool gives the ability to place text and show part
dimensions. Dimension values are calculated from the current CS and visible based on the current
workgroup. Any part of the dimension line, (line, arrowheads or text) may be dragged to reposition
the dimension. Selectionmode is active while the Dimensions palette is active.
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1. Text

2. Align

3. Horizontal

4. Vertical

5. Horizontal
FromOrigin

6. Vertical
FromOrigin

7. Point

8. Angle

9. Radius

10. Diameter

11. Angle to H
Axis

12. Angle to V
Axis

13. Multiple
Dimensionin
gmode

The font used and the size of the the annotation text is controlled by right-clicking on the
Dimensions title bar and selecting Set Font. This opens a dialog that displays the fonts that are
installed on your system.

Text
Enter a note on the part. Place the cursor where you want the note to appear and enter the text.

Align
Gives the distance between two selected points.

Horizontal
The horizontal distance between two selected points.
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Vertical
The vertical distance between two selected points.

Horizontal From Origin
The horizontal distance of a point from the origin of the current CS.

Vertical From Origin
The vertical distance of a point from the origin of the current CS.

Point
The explicit coordinates of a point in the current CS.

Angle
The interior angle of two lines. The exterior anglemay be determined by selecting the dimension
and choosingModify > Reverse Arc (Ctrl-T). This button will also determine the angle between
three points.

Radius
The radius of a selected arc or circle.

Diameter
The diameter of a selected arc or circle.

Angle to H Axis
The angle between a selected line and the horizontal axis.

Angle to V Axis
The angle between a selected line and the vertical axis.

Multiple Dimension mode

Multiple Dimensionmode lets you createmultiple dimensionswith maximumpower and
efficiency. In thismode, you select a dimensioning type and then, after you select a base feature:
Hovering over another feature provides a preview of the dimension; Ctrl+click sets the dimension;
and Ctrl+drag adjusts the dimension’s position.

Workgroups
All created geometry is placed in the active workgroup.Workgroups are separate layers used to
separate different groups of geometry, including custom stock. One or more workgroupsmay be
viewed at a time, however theremay only be one active workgroup. The viewing, selection and
creation of workgroups is accomplished with theWorkgroup list. Workgroup information and
selection can also be performed through theWorkgroup dialog, accessed from theMain palette.

Workgroup List

TheWorkgroup list controls the workgroups. ClickNew WG to
create additional workgroups. The active workgroup is
highlighted. To switch workgroups, click the name of the
desired workgroup. The eye icon show and hide the
workgroups. Click the column header to sort the list. Right-
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click or a workgroup entry in the list to open a context menu
which accesses basicWorkgroup functions and someModify
menu items. The right mousemenu is described in “Workgroup
Right MouseMenu” on page 56.

Background Workgroups

To see inactive geometry contained in other workgroups double-click the eye tomake it visible.
To select multiple workgroups to be viewed as background workgroups, use the Shift key to
select a contiguous group of workgroups and the Ctrl key to add or remove a single workgroup
from the selection. Double-click to change the status of an eye from visible to invisible.

Workgroup Right Mouse Menu

You can right-click theWorkgroup title bar or aWorkgroup list entry to open a context menu.
This contains actions that are commonly used with workgroups:

WG Info
TheWG Info choice opens a dialog that allows you to specify the behavior of geometry in this
workgroup: 
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Workgroup Info dialog for Mill part Workgroup Info dialog for Turning part
Choose Part Stock to use the geometry as a stock shape, or choose Part Geometry to specify that
geometry in the workgroup is used to define the part.

Part Stock
If Part Stock is selected, the geometry in the workgroup will be used for any calculations that
need to look at the stock dimensions, such as Auto Clearance andMaterial Only. The geometry
can be used as the starting stock condition in rendering and simulation, so long as it is a closed
shape.When used in this way, the stock shape can also be used inmachining operations to
adjust the toolpath according to the amount of material to be removed based on the stock
shape.

Extruded geometry in Turning workgroups is extruded along the depth.

New WG
This option creates a new, empty workgroup in the next available number slot. That is, if you have
WGs numbered 1, 3 and 4, creating a newWGwill makeWG#2.

Delete
This option deletes the current workgroup. Any geometry contained within the workgroup will also

be deleted. Youmay also press the key to deleteWGs.

Duplicate Visible WGs
This option will duplicate all the geometry within currently visible workgroups. New workgroups are
not made, only geometry within each workgroup is created. This is functionally the same as

pressing to duplicate geometry but the function is applied on a larger scale.
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Duplicate And…

This option will duplicate geometry and apply a transformation to the
geometry in the current workgroup. This option is functionally identical to
the Duplicate And… command found in theModifymenu, except that it
applies themodification to all geometry in the workgroup. For more
information on Duplicate And…, see the CommonReference guide.

Force Depth…
This option will move all geometry in the current workgroup to a specified depth. For more
information on Force Depth, see the CommonReference guide.

Mirror…
This option will reflect or flip all geometry in the current workgroup about a specified point. For more
information onMirror, see the CommonReference guide.

2d Rotate…
This option will rotate all geometry in the current workgroup about a specified point. For more
information on 2D Rotate, see the CommonReference guide.

Scale…
This option will magnify or shrink all geometry in the current workgroup by a specified amount. For
more information on the Scale function, see the CommonReference guide.

Translate…
This option will move all geometry in the current workgroup by a specified amount. For more
information on Translate, see the CommonReference guide.

Segment Spline…
This option will break all splines in the current workgroup into line segments. For more information
on Segment Spline, see the CommonReference guide.

Sort…
This option allows you to sort all points in the current workgroup. For more information on Sort, see
the CommonReference guide.

Reverse Arcs in Visible WGs
This option will toggle the direction of all arcs in the current workgroup, i.e. clockwise arcs become
counter clockwise and vice versa. For more information on Reverse Arcs, see the Common
Reference guide.
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Change CS (XYZ) of Visible WGs
This option will change all geometry in the current workgroup fromwhichever coordinate system it
is aligned to the current CS. The geometry stays in its current location. For more information on
Change CS (XYZ), see the CommonReference guide.

Change CS (HVD) of Visible WGs
This option will change all geometry in the current workgroup fromwhichever coordinate system it
is aligned to the current CS. The geometry will move to be in the same relative position within the
CS. For more information on Change CS (HVD), see the CommonReference guide.

Show All Workgroups
Switches all the eye icons to open ( ) to display all geometry. The non-active geometry is
displayed in grey.

Show Only Current WG
Changes all the eye icons except currently activeWG to shut ( ). Only geometry in the currently
selectedWorkgroup will be displayed.

Delete Hidden WGs
This commandwill delete allWGswhere the “eye” icon is shut ( ). A one-time warning appears.

Merge Visible WG’s
Open the eye on theWorkgroups that are to bemerged. ( ). A confirmationmessage will be
displayed.

Level 1 Interface and Workgroups
Accessing workgroups is slightly different in the Level 1 interface.Workgroups and theWorkgroup
Info are accessed through theGeometry Creation palette. Clicking theWorkgroup List button
opens theWorkgroup List, which functions identically as in Level 2, while clicking and holding the
Workgroup List button accesses amenuwhich allows quick switching of the active workgroup. A
new workgroupmay also be created from thismenu.
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1. Workgroup Info button
2. Workgroup List button
3. Workgroup List menu

Workgroup Manager
AWorkgroup Manager is available from theWindowmenuwhich provides information in a tabular
format about the points, lines and circles contained in the current workgroup. Print and Save to file
functionality is available from theManager dialog. The list is customizable and can be sorted, saved
and printed.

For more details on themanager capabilities see the CommonReferenceGuide.

Coordinate Systems
Geometrymay be created in, or moved to, different coordinate systems. The Advanced CS guide is
the best place to get more information about this type of geometry. Geometry can be defined using
these other planeswith the Advanced CSmodule. The image is an example of three different
coordinate systems. The circle in each coordinate system is at the same horizontal, vertical and
depth position relative to each coordinate system.

Geometry is not contained in a coordinate system the way it is with workgroups. The coordinate
system used to define geometry can be thought of as an attribute of the geometry and its orientation
to the rest of the part. Coordinate systems are used for 3D geometry creation, rotary part
orientation for machining, multiple work fixture offsets and as a basis for solid modeling. Coordinate
systems are only available in the Level 2 interface.
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3D Geometry
Creating non-planar geometry is the same as planar except you would use connectors that lie in
different coordinate systems.

Printing the Part Geometry
After the part geometry has been created, it can be printed. Geometry can either be printed in black
and white or in color. When the desired geometry is on the screen, choose Drawing (Ctrl+P) from
the Print sub-menu under the Filemenu. To adjust the way the image will print, choose Printing from
the Preferences sub-menu in the Filemenu. The Printing Preferences dialog shown allows the user to
specify how the software will handle the background color. If the printer being used is black and
white, choose the Black onWhite option to ensure that all portions of geometry, including those that
are of a light color, can be seen in the printout.
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Appendix
GibbsCAMhas two interface levels: Level 1 and Level 2. Level 2 is the default and provides amore
complete, feature-rich environment. Level 1 is a simpler interface that some usersmay prefer if they
do not need all the options or flexibility that Level 2 offers. You can think of Level 1 as a training
interface that hides themore complicated features. This section details the different interface
options found in Level 1.

Interface
The interface is different in Level 1. The Floating Toolbar is not present and the CommandsPalette
is simpler.
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Workgroups

To access different workgroups in Level 1, theWorkgroup list and information dialogs are also
located on the geometry palette.
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Not Included In Level 1
Level 1 can be displayed with anyMDD but is truly only useful with generic lathe or 3-axismill
MDDs. All other MDDs require access to items not present in Level 1. Additionally, there are
several things that cannot be done in the Level 1 interface.

• Any surfaces or solidsmanipulation as described in any of the solidsmanuals which includes:

- Global Tolerance settings

- SurfaceMachining

- Solids will not be visible or selectable until switching to Level 2.

• Rotated Coordinates as used in Advanced CS, Mill/Turn or Multi-TaskMachining

- All Coordinate system options are hidden in Level 1, including the grid, lists and palette.

• Advanced Contour and Roughing options

- Stay In Stock

- Material Only

- Advanced Entry And Exit

- Hit Flats

- Open Sides - limited to fixed parameters based on tool size

• Access to someworkspace context menus is disabled.
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Conventions
GibbsCAMdocumentation uses two special fonts to represent screen text and keystrokes or
mouse actions. Other conventions in text and graphics are used to allow quick skimming, to
suppress irrelevancy, or to indicate links.

Text

Screen text.  Text with this appearance indicates text that appears in GibbsCAMor on your monitor.
Typically this is a button or text for a dialog.

Keystroke/Mouse.  Text with this appearance indicates a keystroke or mouse action, such as
Ctrl+C or right-click.

Code.  Text with this appearance indicates computer code, such as lines in amacro or a block of
G-code.

Graphics

Some graphics are altered so as to de-emphasize irrelevant information. A “torn” edge signifies an
intentional omission. Portions of a graphicmight be blurred or dimmed to highlight the item being
discussed. For example:

Annotations on a graphic are usually numbered callouts (as seen above), and sometimes include
green circles, arrows, or tie-lines to focus attention on a particular portion of the graphic.

Faint green borders that outline areaswithin a graphic usually signify an imagemap. In online help
or a PDF viewer, you can click a green-bordered area to follow the link.
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Links to Online Resources

Link URL Action / Description

Go http://www.GibbsCAM.com Opens themain website for GibbsCAM.

Go https://online.gibbscam.com

Opens a restricted website containingmaterials
available for download. Requires aGibbsCAM
Online Services account; to set up an account,
contact GibbsCAM Support.

Go https://store.GibbsCAM.com
Opens the website for the GibbsCAM Student
Store.

Go https://macros.gibbscam.com
Opens a wiki containing documentation and
examples of GibbsCAMmacros. Requires a
GibbsCAM account.

Go http://kb01.GibbsCAM.com

Opens a Knowledge Base article, Contour
Operations Using Thread Mill Tools, that
explains in detail the correct way to program
Contour processes using ThreadMill tools.

Go mailto:Support@gibbscam.com
Runs your email client to create a new message
addressed to the CAMBRIO Technical Support
department for GibbsCAM.

Go mailto:Registration@gibbscam.com
Runs your email client to create a new message
addressed to the CAMBRIORegistration
department for GibbsCAM.

Go mailto:Sales@gibbscam.com
Runs your email client to create a new message
addressed to the CAMBRIO Sales department
for GibbsCAM.

Go http://www.autodesk.com/inventor
Opens an external website that provides more
information on Autodesk Inventor products.

Go http://www.celeritive.com
Opens an external website that provides more
information on VoluMill Ultra High-Performance
Toolpath (UHPT) from Celeritive Technologies.

Go http://www.predator-software.com
Opens an external website that provides more
information on a CNC editor and a virtual CNC
viewer from Predator Software, Inc.

http://www.gibbscam.com/
https://online.gibbscam.com/
http://store.gibbscam.com/
https://macros.gibbscam.com/
http://kb01.gibbscam.com/
mailto:Support@gibbscam.com
mailto:Registration@gibbscam.com
mailto:Sales@gibbscam.com
http://www.autodesk.com/inventor
http://www.celeritive.com/
http://www.predator-software.com/
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–R function 13

–R Geometry 52

2

2d Rotate 58

A

ActiveWorkgroup 55

Air Geometry 14

Arc, Alternate Solutions 52

Auto Clearance 57

AutoShape
Curve 37
Ellipse 31
Gear 32
Offset 29
Polygon 31
Rectangle 30

B

B-Spline 37

Balloons 6

Bolt Circle Creation 20

Button
AutoShape, Cam 34
AutoShape, Ellipse 31
AutoShape, Gear 32
AutoShape, Offset Shape 29
AutoShape, Polygon 31
AutoShape, Rectangle 30
AutoShape, Text Creation 26
Cam 34
Circle, Point & Center Point 24

Circle, Radius & Center Point 24
Circle, Radius & Two Points 25
Circle, Three Features 25
Combine Shapes 35
Connect/Disconnect 12-13, 39
Geometry Expert 46
Line, Axis 23
Line, Between Two Points 22
Line, Mouse Line 23
Line, Parallel and Offset 23
Line, Perpendicular 23
Line, Tangent-Angle 22
Point, Bolt Circle 20
Point, Center Point 21
Point, Matrix Point 20
Point, Mid-Point 21
Point, Mouse Point 21
Point, Point-Angle 22
Point, Point on Arc 21
Point, Polar Point 20
Return 18
Workgroup Selection 55

C

CAD
Combination 10
Free-form 17
Free-Form 9-10
Geometry Expert 9-10

Calculate Gear Values 33

Cam
CW or CCW 35
End Angle 35
End Radius 35
Motion Type 35
Start Angle 35
Start Radius 35
Tolerance 35

CAM 7

Cam Creation 34

Center Point Creation 21

Centripetal (curve) 38
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Index: Chamfer – Gear

Chamfer
defined by Depth 39
defined by Length 39
defined by Side 39

Chamfer-Fillet sub-palette 38

Chamfer Creation 38

Change CS (HVD) of VisibleWGs 59

Change CS (XYZ) of VisibleWGs 59

Change to CS 14

Chord Length (curve) 38

Circle
Connecting 13
Point and Center Point 24
Radius & Center Point 24
Radius & Two Points 25
Three Features 25

Circle sub-palette 24

Circle, Tangent to
a Line and a Circle 25
a Line and a Point 25
Two Circles 25
Two Lines 25

Circles 13, 17

Circularity Tolerance 42

Closed Shapes 11

Combine Shapes 35

Connect & Disconnect Geometry 12-13,
17, 39

Connect / Disconnect 14

Connect/Disconnect button 14, 39

Connecting Features 12

Connections, Breaking 13

Connections, Multiple 40

Connector 9

Construction Geometry 9

CP (Center Point) 18

Crosshair, connecting points 40

Curve
Blending Method 38
Close Shape 37
Control Point 37
Curve Fit 37
Line Fit 37

Curve sub-palette 37

Curve Type
Centripetal 38
Chord Length 38
Foley’s 38
Uniform 38

D

Delete, workgroup 57

Descriptor Point 18

Design CAD 7

Dimension Labels 18

Disconnecting Geometry 13, 39

Duplicate VisibleWGs 57

E

Edge Loop 42

Explicit Point Creation 19

F

Feature
Connected 12
Definition 11
Terminated 13
Trimmed 12
Unconnected 12

Feature Type 46

Feature Type, Geo. Expert 47

Features 11

Fillet button 39

Fillet Creation 18, 38

Fillet Radius on Rectangle 30

Foley’s (curve) 38

Fonts 26

Force Depth 58

G

Gear
Addendum 33
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Index: Gear Creation – Offset Shape Creation

Dedendum 33
Full # Teeth 34
Involute Curve 34
Involute Curve Sample Points 34
Involute Curve Tolerance 34
Major Diameter 33
Minor Diameter 33
Pressure Angle 33
Root Fillet 33
Space Width 34
Tooth Width 34
Top Fillet 33
Type 34

Gear Creation 32-33

Geometry
Chamfers 9
Circles 9
Connections 12
Connector 9
Curves 9
Definition 9
Fillets 9
From Solids 41
Lines 9
Points 9
Printing 61
Terminate 39

Geometry Creation palette 9, 17

Geometry Expert 9-10, 45-46, 48-52
Angle/Radius 47
Arcs vs. Fillets 51
Auto Delete 49
Defaults 49
EP Xd/Xr (Y) 47
EP Z (X) 47
Error Balloons 49
Feature Type 47
Fillet 51
Floating Features 50
Half Points 50
Inserting and Deleting 51
Length 48
LP/CP Xd/Xr (Y) 48
LP/CP Z (X) 48
Point Selection 50
Prompting 48-49
Reference # 47
Rows 51
Using 46

Geometry Expert button 46

Geometry Extraction 41

Geometry, Part Geometry 9

H

Help 6

Hole Extraction 42

I

Inferred Features 19

Intersection
Geometry > Shape > Combine 36

L

Layer, seeWorkgroup 55

Line
Between two points 22
Mouse 23
Parallel Offset 23
Parallel to Axis 23
Perpendicular 23
Tangent Feature at an Angle 22
Through Point at an Angle 22

Line sub-palette 22

Line, Tangent to
a Point and a Circle 24
Two Circles 24

M

Material Only 57

Matrix Point Creation 20

Mid-Line Point Creation 21

Mirror 58

Mouse Point Creation 21

Mouse Position 15

Multiple Points button 18

N

New WG 55, 57

O

Offset Shape Creation 29
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Index: Online Help – Text

Online Help 6

Open Shapes 11, 13

Orientation, of gear 34

Outline 44

Overlapping Connections 40

P

P (Point) 18

Palette
AutoShape 26
Geometry Creation 9, 17-18
Line 22
Point 19
Top Level 6

Part Creation 6

Parting Line 42

PDFs 6

Point on Arc Creation 21

Point Selection dialog 40

Point sub-palette 19

Point, Tangent to Two Features 22

Points 9, 11

Polar Point Creation 20

Polygon Creation 31

Printing Preferences 61

Printing the Part 61

R

Reference # (Label) 47

Return button 18

Reverse Arc 13, 52

Reverse Arcs in VisibleWGs 58

S

Scale 58

Segment Spline 58

Selection Mode 18, 53

Shape button 26

Shape Intersection
Geometry > Shape > Combine 36

Shape Offset 29

Shape sub-palette 26

Shape Subtraction
Geometry > Shape > Combine 36

Shape Union
Geometry > Shape > Combine 36

Shapes
Cams 26
Ellipses 26
Gears 26
Offset 26
Polygons 26
Rectangles 26
Text 26

Single Point button 18

Slice Shapes
Geometry > Shape > Combine 36

Smart Selection 19

Solids 17

Sort 58

Splines 10, 26, 42

Square Corners
in Shape Offset 29

Sub-Palettes 17

Subtraction
Geometry > Shape > Combine 36

T

Tangent Features, creation 19

Terminating Lines 23

Terminators 9

Text
Along an Arc 27
Flow 29
Flow Tab 29
Justification 27
Multiple Line Direction 29
Radial Alignment 27
Setting position of 26
Shapes 29
Size 26
Spacing Tab 28
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Index: Text Creation – Workgroups

Straight Alignment 27

Text Creation 26

Text tab 26

Top Level palette 6

Translate 58

Trim 35

Trim Shapes In
Geometry > Shape > Combine 36

Trim Shapes Out
Geometry > Shape > Combine 36

TrueType 26

U

Uniform (curve) 38

Union
Geometry > Shape > Combine 36

W

Wall Geometry 14

WG Info 56

Workgroup 55
List 55

Workgroup Info 18, 59

Workgroup List 18, 59

Workgroup Summary 60

Workgroup, duplicate 57

Workgroups
Background 56
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